Indicators of
Learner Success

Lower Order
Objectives

Higher Order
Objectives

Prerequisite
Knowledge

Lesson Objectives: MLTK-Brain

Able to build the Brain App on their Magic Leap device Engagement
Positive Engagement on Discord Strategy

Broad grasp of the current state of Magic Leap tooling

Out of Scope
Comfortable navigating MLTK feature set and example scenes
Able to drag-and-drop MLTK prefabs into their own projects
Able to access and follow Discord chat
Comfortable articulating:
o Value of MLTK and its role in the tooling ecosystem
o Value of this workshop to colleagues and managers
Post-Workshop
Paths

Able to leverage MLTK code in new C# MonoBehaviours
Apply Best Known Practices for MR Interaction using MLTK
Habitually give and receive help via Discord

Intermediate Unity (Prefabs, MonoBehaviors, and Components)
Basic C# with learner’s preferred IDE

Foundational Spatial Computing Experience

o Completed HelloCube on a Magic Leap headset

o Prior experience with Unity XR/AR

Content feels immediately useful in a professional capacity
Shared sense of accomplishment from learner-learner sharing

Zero lteration workflows

Multi-user features of MLTK

Unity Canvas, Tracked Pose Driver, Magic Leap Camera
MLSpatialMapper, MLSceneOptimizerBehavior

Remaining MLTK features
Zero lteration workflows
Explore other Discord channels
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April 2nd

Join us on Discord: discord.gg/VSUWSMM


https://discord.gg/VSUWSMM

Have you joined us on Discord yet?
discord.gg/VSUWSMM
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JOIN A SERVER

Enter an invite below to join an existing server.

o Oh, another server huh? The invite will look something like these:

Create a new server and Join a server with an invite
l + Add a Server invite your friends. It's free! code or link.

Looking for more servers to join?
Connect Twitch or YouTube accounts

Join us on Discord: discord.gg/VSUWSMM

MAGIC LEAP
2020
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https://discord.gg/VSUWSMM

Have you joined us on Discord yet?
discord.gg/VSUWSMM

NEED HELP?
- Development issue? Hop on to ¢

community-guideli... &" &

- Device issue? Head over to our

FOLLOW ALONG
Developer Portal:
introductions 0 Twitter:
@ YouTube:

€0, WHAT'S NEXT?
Once you e reas ndaares oy

& 2
N

Join us on Discord: discord.gg/VSUWSMM
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Join us on Discord:

discord.gg/VSUWSMM

Join us on Discord: discord.gg/VSUWSMM

#workshop-general

Drop a meme and say hello

#workshop-feedback

Fill out the Workshop Survey and let us know
we can improve for next time in the chat.

#workshop-help

Having trouble? This is your first line of support.

Workshop help 1, 2, 3

These are audio-only channels. Our Mentors may

direct you here to talk through an issue as a group.
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Join us on Discord:

discord.gg/VSUWSMM

Pinned
Links

Important resources

Pinned Messages

-
e

Setup Quick List

are plnned to eaCh 1. Unzip Unity-Project-Template-0.24.0:

channel. Click the
Pin icon for easy 2. Import MLTK:

reference.

Join us on Discord: discord.gg/VSUWSMM

[ML] Mentors

Users with the [ML]
prefix are from the
Magic Leap team,
here to answer
questions and
provide support!

NOT FOR DISTRIBUTION

CONFIDENTIAL

MAGIC LEAP
2020

®


https://discord.gg/VSUWSMM
https://discord.gg/VSUWSMM




Workshop Resources

p ASSetS

0
1e-0.2
oct.Templa MLTK Worksho

[l magicleap / UnityTemplate

Magic Leap Toolkit (MLTK)

<> Code Issues 0 Pull reque

No description, website, or topics proy

\, Manage topics /

©- 1 commit

Unity 2019.3 Project Template .unitypackage file .unitypackage file
Open via Unity Hub Import into the Unity Project Template Import into the Unity Project
Template

MLTK should be imported first
otherwise you may see broken
references

Join us on Discord: discord.gg/VSUWSMM
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https://discord.gg/VSUWSMM
https://github.com/magicleap/UnityTemplate/archive/v0.24.0.zip
https://github.com/magicleap/Magic-Leap-Toolkit-Unity

atform

";: PC, Mac & Linux Stand

Universal WindSS

& [V tvos

e File > Build Settings

e Select Lumin and then click e Set Lumin SDK to:

Switch Platform

Join us on Discord: discord.gg/VSUWSMM

Common Environment Setup Gotchas

Lumi

e Preferences > External Tools

<username>/MagicLeap/mlisdk/v0.24.
1

private Ke¥

Certificate

solution and Presen
Splash Image

Other Settings

Publishing Settings

Sign Package

Project Settings > Player
Select the Lumin tab
Expand Publishing Settings
Select your ML Certificate
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(re)Generating a Certificate

Urgent: The recent Lumin OS 0.98.10 update requires that you generate
new certificates. Certificates generated before 3/15/2020 will not work.
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0 mogic leop developer Learn  Forums Download  Publish m

Kedar Shashidhar v

Developer Becomeapublisher  Certificates  Grants

ficate Type ilter by Status

Certificates  Devcopment Active

Name Issued Expiration Status Revoke Download

kedar_msistealth 5/3/2019 5/2/2020 Active [©) &

kedar_mlla4667 7/28/2019 7/27/2020 Active [©) R

MAGIC LEAP
2020

developer.magicleap.com > Publish > Certificates

$


https://developer.magicleap.com

Join us on Discord: discord.gg/VSUWSMM

Magic Leap Workshop Troubleshooter

Rerun Validation
Copy Results to Clipboard
Hide this Window

' UnityTemplate - HelloCube - PC, Mac & Linux Standalone - Unity 2019.3.4f1 Personal <OpenGL 4.5

!VI L'Ijrouble.shooter.un|typackage File Edit Assets GameObject Component Magicleap Window Help
is pinned in #workshop-help o — e

ML Remote
Once imported, launch from the Al ) Print Version Shift+Alt+V
menu: Build Native Plugin

Magic Leap > Troubleshoot Project S B Haal tionE ~ ToubleshootProject
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Have you joined us on Discord yet?

discord.gg/VSUWSMM

Oh, another server huh?

Create a new server and Join a server with an invite
Add a Server invite your friends. It's free! code or link.

JOIN A SERVER

Enter an invite below to join an existing server.
The invite will look something like these:

hTKzmak

oking for more servers

[
Join us on Discord: discord.gg/VSUWSMM
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Have you joined us on Discord yet?
discord.gg/VSUWSMM

NEED HELP?
- Development issue? Hop on to ¢

community-guideli... &" &

- Device issue? Head over to our

FOLLOW ALONG
Developer Portal:
introductions 0 Twitter:
@ YouTube:

€0, WHAT'S NEXT?
Once you e reas ndaares oy

& 2
N

Join us on Discord: discord.gg/VSUWSMM
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Join us on Discord: discord.gg/VSUWSMM

Today’s Workshop:
MLTK Brain App
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https://docs.google.com/file/d/18olciEFLnRFEVhqQYwhB5GywD0PeIPNS/preview
https://discord.gg/VSUWSMM

Today’s Host
Developer Evangelist
naschenbach@magicleap.com

@inventonater

Join us on Discord: discord.gg/VSUWSMM

Meet the Team

Kedar shashidnd’

Today’s Primary Instructor
Developer Evangelist
kshashidhar@magicleap.com

@kedarshashi

[ML] in #workshop-help

[ML] Slukas
[ML] Tricia
[ML] Filip
[ML] Josh N

[ML] Daniel
[ML] Alicia
[ML] Chris R
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[ML] Shane Engelman
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Agenda

Environment Set Up
Let’s make sure everyone is ready to rock.

What is Magic Leap Tool Kit?

A high level introduction and map of the current tools.

MLTK-Brain Example

MLTK applied to a medical 3D visualization application.

Wrap Up
Recap what we learned and get ready for next time.

Let us know if we are going too fast!
/
Join us on Discord: discord.gg/VSUWSMM
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.

My Unity Project

(based on Unity-Project-Template-0.24.0)

MLTK

Assets/MagicLeap-Tools
via

.unitypackage file

Join us on Discord: discord.gg/VSUWSMM

What is the Magic Leap Tool Kit?

Magic Leap Toolkit is a collection of Components and Prefabs delivered as a .unitypackage file.

These Prefabs provide developers with useful reusable tools that solve specific real-world problems or to extend
functionality for developing Magic Leap apps.

Today’s
Workshop

Materials
.unitypackage file
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https://discord.gg/VSUWSMM

Today...

We will learn about these features

e Control Input
Unity event binding and interaction
for all Control input events.

e Control Pointer
A spatial targeting, selecting, and
manipulation system that displays
weight and other physical
characteristics

e Keep In Front
Keeps digital content in users view

e Place on Floor
Provides a starting position for an
app’s main content without user
input or complex setups

Join us on Discord: discord.gg/VSUWSMM

MLTK Folder Structure
mProject |

+ -
v (@@ Assets
» Bm MagicLeap
v [@ MagicLeap-Tools
> B Art
» Im Code
v (@ Examples
B Controlinput
B ControlPointer

s KeepinFront
s PlaceOnFloor

» B RampLight
» Bm RuntimeConsole
» B SpatialAlignment
» Bm SurfaceDetails
» Bm Transmission
» Bm Fonts
» Bm Prefabs
» Bm Resources
» Bm Materials
» B Plugins
» Bm Scenes
» B XR
# MLTroubleshooter
» Bm Packages
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Today...

We will learn about these features

Not today...

Please explore these other features on your own!

e Control Input
Unity event binding and interaction
for all Control input events.

e Control Pointer
A spatial targeting, selecting, and
manipulation system that displays
weight and other physical
characteristics

e Keep In Front
Keeps digital content in users view

e Place on Floor
Provides a starting position for an
app’s main content without user
input or complex setups

Join us on Discord: discord.gg/VSUWSMM

Interactive Objects New!

A set of user inputs and objects
that are part of the HandInput
system

Hand Input New!

A plug-and-play tool that provides
stable, smooth hand tracking for
keypoints in any hand pose

Playspace New!
Users define an area in their space
for use in an app

SimpleHandPointer New!
An alternative to the Control
Pointer to enable hand input

Ramp Light

A shading technique which maximizes the
visual quality of Magic Leap’s additive
display.

Transmission
A cross-platform, multiplayer solution for
connecting devices over LAN

Spatial Alignment
Visual alignment for peers connected with

Transmission

Runtime Console

Viewing log messages while running an app

Surface Details
A solution to identify different surface types

NOT FOR DISTRIBUTION
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Keep In Front

B P Keep In Front (Script)

Allowe

Minimi

Flat Location

Keep In Front is a component that keeps content in the user view
while respecting other objects in the scene and attempts to stay in
front of them.

Join us on Discord: discord.gg/VSUWSMM
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Place On Floor

a v Place On Floor (Script)

Content * Content

Flipped Forward

Place On Floor helps locate an area on the floor of the user’s space
where an app can place digital content.

Join us on Discord: discord.gg/VSUWSMM
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Control Input

a v Control Input (Script)

Handedness Any
Follow Control
Events

On Trigger Down ()

Runtime Only : ControlInputExample.WriteLogMessage

B ControlInputExample @

Control Input component provides you with a comprehensive set of Unity
events for interactivity with the Magic Leap Control.

Join us on Discord: discord.gg/VSUWSMM
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Control

B P Pointer (Script) W S

Input Driver ControlPointer (ControllnputDriver ©

Everything

Drag Movement Thresholc0.01

Drag Rotation Threshold 1
Line ion
nt Multiplier
oint Percentage

Bend Prediction Multiplier 14

Magnification &
Effort Magnification Curve

Control Pointer provides a pointer for the manipulation and movement of
digital objects with the Control. Control Pointer includes components that let
users target, select/deselect, and drag/drop objects.

Pointer

v Pointer Receiver (Script)
Draggable v
Kinematic While Idle
Face While Dragging

Match Wall While Dragc

Invert Forward
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Workshop Unitypackage

v B Models

Models N

v 9 BrainPrefab.001.PlaceOnFloor.prefab
BrainPrefab.002.ControlPointer.prefab

. B ra i n .be - m O d e | ¥ BrainPrefab.003.FinesseControl.prefab

NSRS ESESEYESEIESIES

BrainPrefab.004.UserInterfaces.prefab
W# Left Hemisphere Variant.prefab
W9 Pituitary Canvas Variant.prefab
W9 Right Hemisphere Variant.prefab
ﬁ World Canvas.prefab
e User Interfaces
TriggerUITooltip.prefab
v I Scenes
Sce n es v B Completed_Workshop_Scenes
v B MLW.Brain.001.PlaceOnFloor --Complete
v #¥LightingData.asset
. Sta rte r Sce n eS v ReflectionProbe-0.exr
m Od u |es <« MLW.Brain.002.ControlPointer -- Complete.unity
B8 MLW.Brain.003.FinesseControl -- Complete
v #¥LightingData.asset
S H t ReflectionProbe-0.exr
C rl p s <€) MLW.Brain.003.FinesseControl -- Complete.unity
8 MLW.Brain.004.Userlnterfaces-- Complete
<) HelloCube.unity
v € MLW.Brain.001.PlaceOnFloor -- Starter.unity
v B Scripts
v B Completed_Workshop_Scripts

P f b Mm BrainUls
W9 Brain Stem Variant.prefab
re a s §¥ Cerebellum Canvas Variant.prefab
e Completed prefabs for each lesson
ControllerTooltips
HomeUITooltip.prefab
<« MLW.Brain.001.PlaceOnFloor --Complete.unity
s MLW.Brain.002.ControlPointer -- Complete
e Completed Scenes for each lesson gl )
H 1 H 1 v L¥lightingData.asset
e Completed Logic Scripts for this project 7 @refectonprope-0.x
<« MLW.Brain.004.UserInterfaces-- Complete.unity
v ExitOnHome_Complete.cs
v ResetChildren_Complete.cs

&9 Corpus Callosum Variant.prefab
W9 TouchpadUITooltip.prefab
v ReflectionProbe-0.exr
<& EmptyScene.unity
ShowUI_Complete.cs

All None Cancel Import
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Completed Scenes & Associated Prefabs

Scene Name

Associated Prefab

MLW.Brain.001.PlaceOnFloor -- Starter.unity

No associated prefab

MLW.Brain.001.PlaceOnFloor -- Complete.unity

BrainPrefab.001.PlaceOnFloor

MLW.Brain.002.ControlPointer -- Complete.unity

BrainPrefab.002.ControlPointer

MLW.Brain.003.FinesseControl -- Complete.unity

BrainPrefab.003.FinesseControl

MLW.Brain.004.UlControl -- Complete.unity

BrainPrefab.004.UlControl
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MLW.001.PlaceOnFloor -- Starter

Add Brain Model to Our Scene

Open the MLW.001.PlaceOnFloor -- Starter Scene
2. Create a new gameobject and rename it to “{CONTENT]” and place it at the origin
3. Add the BrainPefab.001.PlaceOnFloor Prefab from the Assets/Prefabs folder to your Scene under the
[CONTENT] Game Object in your Hierarchy
a. Set position transform to (0,1,0)
b. Set scale transform to (0.25,0.25,0.25)
4. Rebuild the Lighting. Open the lighting menu under Windows > Rendering > Lighting Settings. Scroll to
the bottom of the window and hit the generate lighting button.

29
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MLW.001.PlaceOnFloor -- Starter

Set Up A Starting Place for our Application

NOT FOR DISTRIBUTION

CONFIDENTIAL

1. Under “[UTILITIES]” create a new gameobject called “PlaceOnFloor” and place it at the origin
2. Add the component PlaceOnFloor to the gameobject
3. Create a new gameobject and rename it to “[GUI]” and place it at the origin
4. Add the prefab Placementinstructions from Assets/Prefabs/ as a child of “[GUI]”
5. Addthe component KeeplnFront to the prefab
6. Inthe PlaceOnFloor gameobject:
a. Add areference to Placementinstructions in the Instructions field
b. Add a reference to [CONTENT] in the content field

MAGIC LEAP
2020

®



MLW.001.PlaceOnFloor -- Starter

= Hierarchy i  # Scene O®Game i @ Inspector @ Lighting
v a ~ 2 @ ) % W ~v Gizmos ¥ o
+ Shaded D E Gizmos @ v PlaceOnFloor
& MLW.Brain.001.PlaceOnFloor --Complete* . e
£ [RENDERING] Tag Untagged yer Default
@ [UTILITIES]
patia
& PlaceOnFl
@ [eun
D [CONTENT]
& MLW.Brain.0

Wiy . Transform

loor osition

NOT FOR DISTRIBUTION

Place On Floor (Script)

P Placementinstructio

© [CONTENT

‘Add Component

M Project B Cons
+ -
& Prefat + Assets > Prefabs
B Debugg B BrainUls
I Informational Bm ControllerTooltips
B Input Brain
B Networking % MLW.Brain.001.PlaceOnFloor
s Rendering 9 MLW.Brain.002.ControlPointer
B Resources ¥ MLW.Brain.003.FinesseControl
B Materials ¥ MLW.Brain.004.UserInterfaces

MAGIC LEAP
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[PAUSE]

Build to Device / Run in Zero Iteration / Questions
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Review of MLW.001.PlaceOnFloor
1.  Removed default content in starter scene
2. Added the Brain Prefab to the scene
3. Created a reference to global [CONTENT] gameobject in PlaceOnFloor component

MAGIC LEAP
2020
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MLW.Brain.002.ControlPointer

Add a Control Pointer to the Scene

1. Create an empty game object in the Hierarchy and
rename it as [INPUT]
a. Setits transform to be at the origin.

B v Pointer (Script)

B ControlPointer (ControlinputDriver)

Everything

2. Drag the ControlPointer prefab from
/Assets/MagicLeap-Tools/Prefabs/Input into the »
Hierarchy as a child of the [INPUT] gameobject. Mi Distance

Dr
a. Setthe following parameters on your Pointer
SCHpt Bendy Weighvt Multiplier

Bend Point Percentage
Bend Prediction Multiplier

Max Distance 2.5

Min Distance 0.5

Bendy Weight Multiplier 0.25

Bend Point Percentage 0.25

Bend Prediction Multiplier 10
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MLW.Brain.002.ControlPointer o ; ‘ =

< MLW.Brain.002.ControlPointer -- C }
Tag Untagged Layer Default

Adding Pointer Intractability to the Brain Model -

i2:) Stem (Mesh Filter)

Select all the children objects of the Brain Prefab. Add the v iy .- Usst R

B v Mesh Collider

v

following components and properties

Mixed.

1. Add a Mesh Collider component T ==
a. Check “Convex” in inspector -
b. Add “PointerinteractablePhysicMaterial” to the

colliders Material Field

2. Add a Pointer Receiver component L ——
a. This will automatically add a rigidbody ‘
b. Check “Is Kinematic”

3. Add Input Feedback component
a. Add audio clip references for each sound EZ!::;T:Z’S;iif’!;’l’,.,,t,

Audio Source

Sa m ple Input Feedback (Script)

NOT FOR DISTRIBUTION
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MLW.Brain.003.ControlPointer

Add Rotatability and Scalability to All Interactable Objects.

1.

Select all children components of the Brain Prefab and add a “Rotation Manipulator” and “Scale

Manipulator” Script. This allows the use of:

The radial dial to rotate objects when selected
Left and Tight tap on the Touchpad to scale up and down
Force Press on the Touchpad to Reset the scale

‘= Hierarchy
llision ¢

Rotation Manipulator (Script)

)03.FinesseControl

bellum

& [INPUT]

d objects cannot be multi-edited

Add Component

36
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MLW.Brain.002.ControlPointer

Setting Up Double Tap Home to Exit App

1. Inyour scripts folder create a script called
“ExitOnHome”
a. Add a single function called ExitApp with the
following code.
2. Add the ExitOnHome script as a component on the
ControlPointer gameobject
3. Onthe Controllnput component in ControlPointer
in the “On Double Home ()” event callback. Add a
new callback and reference the ControlPointer
gameobject.
a. Select ExitOnHome.ExitApp as the function
to call.

public void ExitApp ()
{

#if UNITY EDITOR

Debug.Log ("Exit to Home: Unity Editor
Quit");

UnityEditor.EditorApplication.isPlaying
false;
#else

Application.Quit () ;
#endif

On Double Home ()

Runtime Only v ExitOnHome.ExitApp

A ControlPointer (ExitOr ®

On Bumper Down ()

37
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[PAUSE]

Build to Device / Run in Zero Iteration / Questions

Review of MLW.002.ControlPointer

1.

o & W N

Added a controller pointer prefab to your scene and control parameters

Created a script ExitOnHome.cs that exits your application

Added an event callback in Controllnput to the ExitOnHome.cs Script on Double Tap Home

Enabled basic pointer interaction to each brain game object by adding colliders & MLTK scripts

Enabled rotation and scale manipulation to each brain game object by adding MLTK scripts

NOT FOR DISTRIBUTION
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= Hierarchy Bt S ® |ighting

MLW.Brain.003.FinesseControl v Sphere
03.FinesseControl - }
Gl Tag Untagged ¥ Layer Default

Transform

Adding a way to globally control the brain model '7 T

1. Right Click on the Brain Prefab in your scene hierarchy and

Bl sphere (Mesh Filter)

select “Open Prefab Asset” 5, < [Mestinufiaees

7 Pituitary € v Sphere Collider

T
- Rigidbody

2. Right click on the root gameobject and navigate to 3D @ oo
Object > Sphere to add a sphere gameobject to your prefab
a. Set position transform to (0,-0.5,0) c
b.  Set scale transform to (0.2,0.2,0.2) AT ——
c. Drag all brain game objects to be a child of the
sphere
3. Add the following components to your Sphere.
a. Pointer Receiver

b.  Rotation Manipulator

c.  Scale Manipulator B - Pursuit Joint (Script)
v Pointer Receiver (Script)
d. |npUt FeedbaCk { v Audio Source

v Input Feedback (Script)

e. MSA Source
4. Set “Is Kinematic” in Rigidbody to True
5. Add “PointerinteractablePhysicMaterial” to Sphere Collider
6. Add audio clip references in Input Feedback
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MLW.Brain.003.FinessePointer

Resetting the Brain using the Home Button
1. Create a script called ResetChildren.cs

2. Add the following private member variables //Setting the following private member variables
private Vector3[] originalPositions;

private Quaternion[] _originalRotations;
private Vector3[] originalScales;
private bool initialized = false;

3. Add the following functionality in Start()

void Start ()
{
if (transform.childCount > 0)
{
_originalPositions = new Vector3[transform.childCount];
_originalRotations = new Quaternion[transform.childCount];
_originalScales = new Vector3[transform.childCount];

for(int i = 0; i < transform.childCount; i++)

{

_originalPositions[i] gameObject.transform.GetChild (i) .localPosition;
_originalRotations[i] = gameObject.transform.GetChild (i) .localRotation;

_originalScales[i] = gameObject.transform.GetChild(i).localScale;

}

_initialized = true;

M
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MLW.Brain.003.FinessePointer

Resetting the Brain using the Home Button
1. In ResetChildren.cs add a function ResetChildTransforms()

public wvoid ResetChildTransforms ()
{
if(_initialized)
{
for (int 1 = 0; i < transform .childCount; i++)

{
Transform child = gameObject .transform.GetChild(i);

child .localPosition = originalPositions([i];
child .localRotation = originalRotations[i];
child .localScale = originalScales[i];

2. Add ResetChildren.cs as a component on the Sphere gameobject

3. Inyour ControlPointer gameobject in the Controllnput component, add a callback to On Home Button

Tap()

On Home Button Tap ()

Runtime Only v ResetChildren_Complete.ResetChildTransforms

B Sphere (ResetChild ®
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MLW.Brain.002.ControlPointer

Adding Audio Spatialization to Interaction Sounds

1. On the Main Camera gameobject under rendering.

Add an MSA Listener Component
2. Select all interactable brain components:
a. Add an MSA Source Component
b.  On the Audio Source:
i. Check the Spatialize box
ii. Set Spatial Blend parameter to 3D

a i |v @ v MSA Listener

trolPointer -- Complete

= Hierarchy ai v MSA Source
+v a VidHi-obiect adk ;
< MLW.Bra 002.ControlPointer -- Co : W v Audio Source

AudioClip
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[PAUSE]

Build to Device / Run in Zero Iteration / Questions

Review of MLW.003.FinessePointer
1.  Modified the Brain Prefab in the scene with a global sphere object that parents brain game objects

2. Added full pointer interaction to the Sphere gameobject

3. Created a ResetChildren.cs script that resets the transforms of all children gameobjects
4. Added an event callback in Controllnput to ResetChildren on Single Tap Home

5. Added audio spatialization to input feedback sounds
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MLW.Brain.004.UlControl

Adding Uls to each Brain Component

1. In Assets/Prefabs/BrainUls drag each brain component
Ul to the hierarchy as a child of each brain component
model.

a. Disable all Ul components

Tag Untagged ¥ Layer Default
Multiple F Select

¢+ Rect Transform

D [INPUT]
World Space

None (Camera)

Default

h Nothing

T v Graphic Ravcaster

BrainUls

m Plugir
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MLW.Brain.004.UlControl

Displaying and Hiding the Uls with the Control Bumper

1. Create a script called ShowUl.cs
using MagicLeapTools;

2. Add MagiclLeapTools as a namespace.
3. Add the following public and private member variables private bool enabled — false;
public PointerReceiver pointer;

4. Create Two New Functions, EnableUl() and HideUI()
public wvoid EnableUT () {

if (pointer != null) {
if (pointer .Dragging) {
_enabled = ! enabled;
gameObject. SetActive ( enabled);

}
else(
Debug. Log ("Null Pointer in Parent");

public wvoid HideUI () {
_enabled = false;
gameObject. SetActive ( enabled);
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MLW.Brain.004.UlControl

Displaying and Hiding the Uls with the Control Bumper
1. Inside ResetChildren.cs make the following modification to the ResetChildTransforms() function

public void ResetChildTransforms ()

{

if(_initialized)

for

{

(int 1 = 0; 1 < transform.childCount; i++)

Transform child = gameObject.transform.GetChild (i) ;

child.localPosition = originalPositions[i];
child.localRotation = originalRotations[i];
child.localScale = originalScales([i];

ShowUI_Complete showUI = child.GetComponentInChildren<ShowUI_Complete>() ;
if (showUI != null)

{
showUI.HideUI() ;
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Displaying and Hiding the Uls with the Control Bumper

1.

MLW.Brain.004.UlControl

Select all 6 BrainUl Objects. Add ShowUI as a script to all of them.

a.

For each ShowUI component add a reference to the “PointerReceiver” component in its parent game object

‘= Hierarchy

+ -

<« MLW.Brain.004.UserInterfaces-- Co

RING]

Cerebellum Canvas Variant

ag Untagged ¥ Layer Default

Open Select

H

Rect Transform

0

Canvas

4

Canva

#

Graphic Raycaster

1

Show UI_Complete (Script)

A Cerebellum (PointerReceive ®

Add Component
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Displaying and Hiding the Uls with the Control

Bumper

1. In the ControlPointer game object on the

Controllnput component, add callbacks for each of
the ShowUlI objects and their respective EnableUl()

functions.

MLW.Brain.004.UlControl

&9 ControlPointer

Userinterfaces-- Co

© Inspector ® |ighting

On Home B
Runtime On v ResetChildren_Complete.Rese v
A Sphere (1@

On D le Home ()

Runtime On~ ExitOnHome_Complete.ExitAp|~
A ControlPi ®

+ —
On Bumper vn ()

Runtime On~ ShowUI_Complete.EnableUl
B Cerebell ®

Runtime On~ ShowUI_Complete.EnableUl
BCorpus C®
Runtime On~ ShowUI_Complete.EnableUl
BlLeft Hem®
Runtime On~ ShowUIl_Complete.EnableUl
ARight He1 ®
Runtime On~ ShowUI_Complete.EnableUl
A Pituitary ®
Runtime On~ ShowUI_Complete.EnableUl
A Brain Ste ®
+
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MLW.Brain.004.UlControl

Adding Tooltip Instruction Displays on the Control

1.

In Assets/Prefabs/ControllerTooltips drag all three tooltip prefabs to be children of the ControlPointer gameobject.

Y. Bt~ Gizmos
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[PAUSE]

Build to Device / Run in Zero Iteration / Questions

Review of MLW.004.UIControl

1.

o G g O

Added Brain Ul prefabs to each brain gameobject

Created a ShowUl script that enables, disables, and hides the Ul components

Modified the ResetChildren script to disable all Uls on home button press

Added the ShowUI script as a component on each brain Ul

Added callback references to ShowUIl script on bumper press in Control Input

Added Controller Toooltip prefabs as children of the ControlPointer gameobject
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Today...

We learned about these features

Not today...

Please explore these other features on your own!

e Control Input

Unity event binding and interaction
for all Control input events.

Keep In Front
Keeps digital content in users view

Place on Floor

Provides a starting position for an
app’s main content without user
input or complex setups

Control Pointer

A spatial targeting, selecting, and
manipulation system that displays
weight and other physical
characteristics

Interactive Objects New!

A set of user inputs and objects
that are part of the HandInput
system

Hand Input New!

A plug-and-play tool that provides
stable, smooth hand tracking for
keypoints in any hand pose

Playspace New!
Users define an area in their space
for use in an app

SimpleHandPointer New!
An alternative to the Control
Pointer to enable hand input

Ramp Light

A shading technique which maximizes the
visual quality of Magic Leap’s additive
display.

Transmission
A cross-platform, multiplayer solution for
connecting devices over LAN

Spatial Alignment
Visual alignment for peers connected with

Transmission

Runtime Console

Viewing log messages while running an app

Surface Details
A solution to identify different surface types
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Help us Improve!

Link to the survey is pinned in #workshop-feedback

0 magic
leap

;\vlagic Lezlp \\kn‘kshop - Participzmt Sur\‘e_\'

Thank you for joining us for the Magic Leap Online Workshop on April 2nd! It was a pleasure
to virtually work with all of you, and we hope you enjoyed your time with us.

We strive to make these events as helpful for you as possible, and your feedback goes a

long way! We would greatly appreciate it if you could take a few minutes to complete the
survey below.

* Required

How sarisfied were you with the event?
1 2 3 4 5

Not Satisfied At All O O O O O Extremely Satisfied

Would you participate in another workshop like chis one?

Q Yes

forms.gle/jz7MtOW7bGvQUpa97
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https://forms.gle/jz7Mt9W7bGvQUpq97

SPRING 2020 #MLDEVJAM

magi.ca/djsp20



http://magi.ca/djsp20
https://creator.magicleap.com/learn/guides/publish-concepts

APPLY FOR ACCESS HARDWARE

magi.ca/hardware



https://magi.ca/hardware

JOIN THE NIST CHARIloT CHALLENGE

| -
c H I OT e PUBLIC SAFETY
C HALLENGE N‘Sl- PSCR ﬁg?s':lég;am
"munications S -2
. A‘ ' -~

Develop intuitive AR interfaces for first
responders or incident command,

utilizing smart building and personal 3888 ooo
area network sensor data. )

Create user-centered public safety
technology. Win prizes and acceleration AR CONTEST
services. Empower first responders. PRIZE POOL

TAKE ACTION » Learn more at chariotchallenge.com

Submit your idea for the

Build Augmented Reality Interfaces
@ for First Responders Contest by:

May 6, 2020

Go to chariotchallenge.com to learn more and register for
the informational webinar on April 14th, 2020 at Tlam MT

CHALLENGE PARTNERS:

0 magic —FIRsTNET. - [(552Y  hlueforce

leap First Responder N Built with AT&T The Safety Company DEVELOPMENT
Network Authority®
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https://magi.ca/hardware

AY CONNECTED!

Developer Forums:
Twitter:

Discord:


https://forum.magicleap.com/hc/en-us/community/topics
https://twitter.com/magicleapdevs

60

NOILNGI¥LSId ¥O4 LON
IVILN3AIINOD

ocot
dv3TOIoVIN

¢




